## Contents

CONSTRUCTIONS DATABASE USER GUIDE ........................................................................... 1
1 INTRODUCTION .................................................................................................................. 3
2 UNITS ................................................................................................................................. 4
3 MAIN DIALOG – PROJECT CONSTRUCTIONS ................................................................ 5
   3.1 OUTLINE .......................................................................................................................... 5
   3.2 CONSTRUCTION CLASSES & CATEGORIES ..................................................................... 6
   3.3 PROJECT CONSTRUCTION COLUMNS ............................................................................ 8
   3.4 MAIN MENU .................................................................................................................... 9
   3.5 TOOLBAR ....................................................................................................................... 12
   3.6 SIDE PANEL .................................................................................................................. 14
4 EDITING AN OPAQUE PROJECT CONSTRUCTION .......................................................... 15
5 EDITING A GLAZED PROJECT CONSTRUCTION ............................................................... 22
6 CONSTRUCTION ORIENTATION ....................................................................................... 32
7 PROJECT MATERIALS ....................................................................................................... 33
8 SYSTEM OR LIBRARY CONSTRUCTIONS ....................................................................... 37
9 SYSTEM OR LIBRARY MATERIALS .................................................................................... 38
10 SHADING DEVICES ......................................................................................................... 39
11 DERIVED PARAMETERS .................................................................................................. 45
   11.1 DERIVED PARAMETERS (OPAQUE CONSTRUCTION) ................................................... 45
   11.2 DERIVED PARAMETERS (GLAZED CONSTRUCTION) .................................................. 47
12 CONDENSATION ANALYSIS ............................................................................................. 49
13 HINTS & TIPS ................................................................................................................... 51
   13.1 MANUFACTURERS’ DATA ............................................................................................ 51
   13.2 INTERSTITIAL BLINDS AND VENTILATED CAVITIES ................................................. 52
   13.3 AIR PARTITIONS ......................................................................................................... 52
   13.4 EDITING MATERIALS ................................................................................................... 53
14 COMPOSITE LAYERS ....................................................................................................... 54
15 BRE MATERIALS .............................................................................................................. 55
16 COST PLANNING AND LIFE CYCLE SOFTWARE ......................................................... 59
   16.1 CONSTRUCTION DIALOGS .......................................................................................... 59
   16.2 MATERIALS DIALOGS ............................................................................................... 59
1 Introduction

This User Guide explains how to use the Constructions Database user interface.

The Constructions Database (formerly called ApCDB) provides facilities for viewing and editing constructions used throughout the VE (e.g. the thermal applications ApacheCalc, Apache Loads, ApacheSim, Part L/J and other compliance and ratings applications; lighting, cost planning and life cycle applications; etc.).

A construction defines the thermal properties of a building element such as a wall, ceiling or window. It consists of a number of layers of different materials, together with thermal properties of the materials, surface properties and other attributes used in thermal analysis.

There are two main thermal classes of construction, Opaque and Glazed, with different parameter sets. Two extra classes are defined for use in the cost planning and life cycle software – Hard Landscaping and Misc. Further classes may be added in future. These classes are further broken down into categories – external walls, partitions, internal windows, roof lights and so on.

The purpose of the Constructions Database is to assemble a set of constructions for use in the project. It provides facilities for creating, viewing, editing and copying constructions, aided by access to central ‘system’ and ‘library’ databases of constructions and materials. It also provides facilities for condensation analysis.

Project constructions created in the Constructions Database may be assigned to building elements, individually or collectively, in the Apache View (and other thermal compliance views).

At the room creation stage, in ModelIT, constructions may also be set using a Construction Template, which assigns a pre-set construction to each category of building element in the new room.

Routes into the Constructions Database are provided from the Apache View (and other thermal compliance views) and the Template Manager. The Template Manager provides a facility for transferring constructions from one project to another.

Accurate construction data is critically important for the integrity of the thermal model. The function of the Constructions Database is to facilitate the process of setting up and checking this data.
2 Units

Construction attributes in the Constructions Database are displayed in the current Units System (metric or IP). The Units System may be changed using the <VE> menu option Tools >> Preferences >> Units.
3 Main dialog – Project constructions

3.1 Outline

The main dialog, headed Project constructions, displays tabular edit grids of the constructions in the project, organised in tabs. These tabs are usually filtered to individual categories or classes, but there are also other special tabs with different filters, e.g. the In-project tab lists all constructions in use in the project. By double-clicking on a construction ID you can display its properties and edit them. Options, in the side pane, main menu or context menu, provide further operations on the project constructions such as creating, deleting, copying and pasting.

The main menu also provides access to features such as the system and library databases of constructions and materials, printing options and condensation analysis.

When you first enter the Constructions Database with a new project you will see a list of default constructions, together with any additional constructions that have been brought into the project via templates. The Constructions Database facilities allow you to add to and edit these constructions so that they accurately reflect the thermal properties of the elements in the building.

Figure 1 Constructions database main dialog – Project constructions
3.2 Construction classes & categories

Constructions are divided into classes with different thermal property sets. There are two thermal classes – Opaque and Glazed. If particular cost planning and life cycle software is licensed, there are two other non-thermal classes – Hard landscape and Misc. In the case of opaque constructions thermal capacity, as defined by density and specific heat capacity, is important. Glazed constructions, by contrast, are to a good approximation massless, but they require properties characterizing their solar transmission properties. Hard landscape and Misc. constructions have similar properties to Opaque constructions plus some specific extra properties.

The classes of construction are further broken down into categories, as follows:

Opaque constructions:
- External Wall
- TSC Wall
- Internal Partition
- Ground/Exposed Floor
- Roof
- Active Thermal Roof
- Internal Ceiling/Floor
- Active Thermal Ceiling/Floor
- Door

Glazed constructions:
- External Window
- Internal Window
- Roof Light

Hard landscape constructions:
- Pavement/sidewalk (private)
- Site hard landscape
- Site parking
- Site pervious hard landscape
- Site road

Misc. constructions:
- Double facade
- Foundation
- Gutter
- Shape beam
- Shape column
- Shape lintol
- Shape stairs
- Solid beam
- Solid column
- Solid lintol
- Solid stairs
- Structural frame
The construction categories in the Opaque and Glazed classes correspond to categories of building element used for construction assignment in the Apache View. The thermal parameter sets for constructions are broadly similar for categories belonging to the same class (Opaque or Glazed), but in some cases differ in respect of their Building Regulations parameters and default values for surface resistance.

Tabs on the tabular edit grid are arranged to give access to the following:

Tabs for constructions in the Opaque class - separate tabs for each category:

- **External Wall** – Opaque class, Wall category
- **TSC Wall** – Opaque class, Wall category
- **Partition** – Opaque class, Partition category
- **Ground floor** – Opaque class, Ground floor category
- **Roof** – Opaque class, Roof category
- **Active Thermal Roof** – Opaque class, Roof category
- **Internal Ceiling/Floor** – Opaque class, Internal Ceiling/Floor category
- **Active Thermal Ceiling/Floor** – Opaque class, Internal Ceiling/Floor category
- **Door** – Opaque class, Door category

Tabs for constructions in the other classes - single tabs covering all categories in the class:

- **Glazed** – Glazed class, all categories
- **Hard landscape** – Hard landscape class, all categories
- **Misc.** – Misc. class, all categories

Tabs for constructions in any class or category:

- **Assigned (thermal)** shows constructions that are assigned to thermally active elements in the model.
- **Assigned (non-thermal)** shows constructions that are assigned to thermally inactive elements in the model.
- **Costs/LCA** shows only those constructions that have Data source BRE Impact, with extra columns showing the data related to costing and life cycle analysis.
- **UK Part L** shows only those constructions that have Data source UK NCM – this shows all constructions that have been automatically added from UK NCM templates for use in UK Part L analysis.

NB this document describes the default tab status and dialog size. As with other tabular edit dialogs the tabs, columns and filtering can be customized and the dialog can be resized. These changes are saved between sessions for your particular Windows username.
### 3.3 Project construction columns

Within each tab a list of project constructions is displayed, with the following columns of summary information:

<table>
<thead>
<tr>
<th>ID</th>
<th>A unique identifier assigned to the construction when it is created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>The construction category (only displayed if the tab is not filtered to just one category).</td>
</tr>
<tr>
<td>Assigned</td>
<td>Whether this construction is assigned to elements in your project (not displayed – because not necessary – on the In-project tab).</td>
</tr>
<tr>
<td>Description</td>
<td>The description assigned to this construction.</td>
</tr>
<tr>
<td>Data source</td>
<td>The construction may be generic or specific to a particular regulation or rating system (e.g. NCM, Green Mark).</td>
</tr>
<tr>
<td>U-value</td>
<td>The U-value of the construction may be calculated by several methods: currently CIBSE, EN-ISO or ASHRAE. In the case of glazed constructions the U-values are net U-values including the effect of the frame.</td>
</tr>
<tr>
<td>Thickness</td>
<td>The overall thickness of the construction.</td>
</tr>
<tr>
<td>Notes etc.</td>
<td>This field is available for your notes but is also written to by various compliance converters when creating new constructions that they may need.</td>
</tr>
<tr>
<td>(Other columns)</td>
<td>Various other columns are also displayed for specific tabs, e.g. the Ground floor tab has a Ground contact floor column, and the Doors tab has a Door type column. Some of the tabs, specific to particular cost planning and life cycle software, display a considerable number of extra columns with data needed by various parts of this software. See the documentation for this software.</td>
</tr>
</tbody>
</table>

To edit a construction, double-click the grid row on the ID cell. Alternatively select the construction and then use one of four Edit construction options (the button, the side panel option, the main menu option or the context menu option).
3.4 Main menu

When editing project constructions a main menu is available. When editing system or library constructions only a context menu is available. Some of the menu options are also available on the side panel, the toolbar or the context (right-click) menu.

3.4.1 File menu

Save: Saves the project constructions and materials.

Properties…: Displays the project pathname and statistics on the project constructions and materials.

Close Window: Exits the Constructions Database. You will be prompted to save your edits.

3.4.2 Edit menu

Find construction…: Displays a dialog where you can search for project, system or library constructions containing particular text strings in either their IDs or descriptions. Constructions containing the search strings are then listed and may be selected for editing.

Add new construction: Creates a new construction in the current category (or the most sensible category for a multi-category tab). Not available from the tabs displaying more than one category such as Hard landscape or Misc. The exception, for convenience, is the Glazed tab, where it is enabled but will always create a construction in the External Window category (this category can be changed after creation).

Duplicate construction: Creates a copy of the currently selected construction.

Delete construction(s): Removes the selected constructions from the project unless they are assigned to elements in the model.

Edit construction…: Displays a dialog to edit the construction.

Preferences…: Displays a dialog where you can set grid colours.

Copy construction to project: Copies the construction to the project. This is only enabled when editing system or library constructions.

3.4.3 View menu

Toolbar: Toggles the displays of the toolbar.

Side panel: Toggles the displays of the side panel.

Status bar: Toggles the displays of the status bar.

Refresh: Refreshes the display of the grid.

System materials…: Displays the materials in the system database and allows them to be copied to the clipboard for pasting into a project construction. See System materials below.

System constructions…: Displays the constructions in the system database and allows these constructions and their materials to be copied to the clipboard for pasting into a project construction. See System constructions below.
Project materials...: Displays the materials used in the project constructions and allows them to be copied to the clipboard for pasting into another project construction. See Project materials below.

Review manager...: Provides facilities for viewing, printing or copying a textual description of selected project constructions.

Construction usage...: Displays a list of elements in the model that use the currently selected construction.

Library (constructions and materials): Displays a sub-menu giving you access to any of the library materials or constructions. For example there is an IMPACT library for use in the cost planning and life cycle software.

3.4.4 Settings menu

Wind exposure...: Allows you to set the wind exposure index used in ApacheCalc to calculate external surface resistances. Choose from the following options:

- Sheltered: sheltered from the wind
- Normal: typical wind exposure
- Severe: severe wind exposure (e.g. coastal)

The wind exposure index is used in ApacheCalc to calculate the external surface resistance of walls, windows, roofs etc. when a value is not explicitly entered in APcdb. This parameter may also be set in ApLocate. Note that ApacheSim has its own method for calculating external surface heat transfer.

Enable composite layers: Allows you to be able to create composite layers in a construction layer, where a single layer is composed of 2 or 3 separate materials in give proportions. Therefore this should be enabled if you need to create constructions with composite layers.

Composite layers are generated in certain ASHRAE wizard-generated constructions. However these do not normally require subsequent editing. See Composite layers for details.

Composite layers are also used in the cost planning and life cycle software where sub-layers using real materials can be used to increase the accuracy of material usage. This software imposes certain rules on allowed combinations of BRE materials in a composite layer; after any such edit any rule violations will be checked and if necessary a validation window will display showing the rule violations and inviting you to fix them or enter a justification for the edit. See BRE materials for details.

3.4.5 Calculations menu

Derived parameters...: Displays a set of derived parameters summarising the characteristics of the currently selected construction. See Derived parameters below.

Condensation prediction...: Accesses a facility for performing condensation analysis on the currently selected construction. See Condensation analysis below.

3.4.6 Actions menu

Purge unused project constructions: Removes all constructions that are not assigned to any elements in your model.

Delete selected constructions: Identical to Delete constructions in the Edit menu.
3.4.7 Tools menu

*Manage Filters...:* Displays the standard tabular edit feature which allows you to manage the filters controlling each tab.

*Configure tabs and columns...:* Displays the standard tabular edit feature which allows you to edit the columns that appear on this tab.

*ASHRAE construction wizard...:* Displays the *ASHRAE Assembly Wizard* dialog, where you can create constructions suitable for use in ASHRAE compliance. Some of these may generate constructions with composite layers (see *Composite layers*). See also *ASHRAE 90.1 tables* (A3.1a/b etc.).

![Figure 2 ASHRAE Assembly Wizard](image)

*Create target construction...:* Displays the *Target construction creator* dialog, where you can create a construction with a desired category, description, U-value and cM value. The rules for calculating the cM value (the effective thermal capacity) of a wall floor, ceiling etc. can be found in the CEN standard: prEN 13790.
Ground contact floorplans...: Displays the Ground-contact Floorplans dialog. This allows you to manually specify properties of levels of the building which are in contact with the ground, for use (for example) in UK Part L2 where these details are essential for ensuring an adequate U-value for ground-contact walls and floors. The properties may also be assigned automatically from the building geometry. Details of this dialog and related utilities are described in Section 4.
constructions only a subset of the commands is available. All the commands are also available on the side panel, the main menu or the context (right-click) menu.

**Figure 5 Toolbar**

- *Save the database* – same as *File->Save* on the main menu.
- *Open review manager to review or print constructions* – same as *View->Review manager...* on the main menu.
- *Open a dialog to find constructions* – same as *Edit->Find construction...* on the main menu.
- *Add a copy of the selected constructions* – same as *Edit->Duplicate construction* on the main menu.
- *Add a new construction* – same as *Edit->Add new construction* on the main menu.
- *Edit selected construction* – same as *Edit->Edit construction...* on the main menu.
- *Delete selected constructions* – same as *Edit->Delete construction(s)* on the main menu.
- *View where this construction is used in the model* – same as *View->Construction usage...* on the main menu.
- *View the system materials* – same as *View->System materials...* on the main menu.
- *View the system constructions* – same as *View->System constructions...* on the main menu.
3.6 Side panel

A side panel is available with several commands. When editing system or library constructions only a subset of the commands is available. All the commands are also available on the toolbar, the main menu or the context (right-click) menu.

![Side panel](image)

**Save project** – same as File->Save on the main menu.

**Add new construction** – same as Edit->Add new construction on the main menu.

**Duplicate construction** – same as Edit->Duplicate construction on the main menu.

**Delete construction(s)** – same as Edit->Delete construction(s) on the main menu.

**Edit construction** – same as Edit->Edit construction... on the main menu.

**Purge unused project constructions** – same as Actions->Purge unused project constructions on the main menu.

**View system materials...** – same as View ->System materials... on the main menu.

**View system constructions...** – same as View ->System constructions... on the main menu.

**View user guide...** – same as Help->User guide... on the main menu.

**Refresh** – same as View->Refresh on the main menu.

**Manage filters...** – same as Tools->Manage Filters... on the main menu.

**Configure tabs and columns...** – same as Tools->Configure tabs and columns... on the main menu.
4 Editing an Opaque Project Construction

This dialog appears when an opaque project construction is selected for editing by means of a double click or the Edit selected construction icon. It displays the properties of an opaque construction and allows them to be edited. The dialog includes tabbed sections containing the various settings for the construction. Note: The Functional Settings and Frame tabs are only displayed if they have relevant data for the category of construction being displayed:

![Figure 7 Opaque construction](image)

The fields and buttons displayed on the dialog are described below. Fields appearing on a white background are editable. When setting this data it is important to understand the conventions applied to the orientation of constructions and the ordering of their layers, which are described in the section headed Construction orientation.

**Description:** a description of the construction in words.

**ID:** a unique identifier assigned to the construction when it is created.

**External:** Shows the colour used by Radiance for the internal surface when this construction is assigned. When clicked, displays a colour picker allowing the assigned colour to be changed.

**Internal:** Shows the colour used by Radiance for the internal surface when this construction is assigned. When clicked, displays a colour picker allowing the assigned colour to be changed.

**Performance:** The type of U-value calculation used (CIBSE, EN-ISO or ASHRAE). Note that the EN-ISO method does not take account of the entered values for emissivity, surface resistance or wind exposure.

**U-value:** the U-value of the construction, calculated by the selected method.

**Thickness (non-editable):** the thickness of the construction, calculated as the sum of the layer thicknesses. This is used in the setting of room inner volumes and surface areas in rooms for which the Inner Volume flag is turned on.

**Thermal mass Cm (non-editable):** the thermal capacity per unit area and temperature rise.
**Total R-value (non-editable):** total resistance of all layers (does not include inside and outside surface resistances)

**Mass (non-editable):** the area density of the construction, mass per unit area, calculated from the densities and thicknesses of the construction layers.

**Weight category:** a field describing the Thermal mass $C_m$ above:
- Very lightweight – thermal mass less than 95 kJ/m$^2$K
- Lightweight – thermal mass less than 137.5 kJ/m$^2$K
- Mediumweight – thermal mass less than 212.5 kJ/m$^2$K
- Heavyweight – thermal mass less than 315 kJ/m$^2$K
- Very heavyweight – thermal mass greater than or equal to 315 kJ/m$^2$K

**Surfaces Tab**

**Outside surface:**

*Emissivity:* the emissivity of the outside surface of the construction. Values are provided in Table 23 in the Apache Tables document. Most materials have an emissivity of about 0.9. Lower values apply to unpainted metals.

*Resistance:* the thermal resistance between the outside surface and its environment. This is the reciprocal of the outside heat transfer coefficient, which is made up of convective and radiative components. Ticking the default box displays a standard value determined from the construction category, together with the Wind exposure in the case of external adjacency. The default value is used in the ApacheCalc programs. In ApacheSim it is replaced by algorithms that take account of the changing heat transfer conditions at every time step. If the default box is not ticked, the entered value is used by all programs.

*Solar absorptance:* the fraction of incident solar radiation absorbed by the surface. This is a function of the colour and surface finish. Typical values are given in Table 14 in the Apache Tables document or CIBSE Guide A.

**Inside surface:**

*Emissivity:* the emissivity of the inside surface of the construction.

*Resistance:* the thermal resistance between the inside surface and its environment. This is the reciprocal of the inside heat transfer coefficient, which is made up of convective and radiative components. Ticking the default box displays a standard value determined from the construction category. The displayed default value is used in the ApacheCalc programs. In ApacheSim it is replaced by algorithms dependent on simulation options. If the default box is not ticked, the entered value is used by all programs.

*Solar absorptance:* the fraction of incident solar radiation absorbed by the surface. This is a function of the colour and surface finish. Typical values are given in Table 14 in the Apache Tables document or CIBSE Guide A.

**Functional Settings Tab**

This tab is only displayed if the construction belongs to the *Ground Floor, External Wall* or *TSC Wall* categories.

*Ground-contact Floor* or *Ground-contact Wall:* by ticking this box, a construction can be identified as a ground-contact floor or wall.
Adjust: When the Ground-contact floor/Wall box is ticked the Adjust button may be used to adjust the construction properties to make allowance for the building geometry.

CIBSE uninsulated U-value: For the purposes of Part L2 of the UK Building Regulations, the U-value of an uninsulated floor calculated using the parameters set in the Ground-contact U-value adjustment dialog (accessed via the Adjust button). These parameters must be correctly set for Part L2 analyses. The rules state that where the U-value of an uninsulated floor of the same area and exposed perimeter is less than 0.25 W/m²K, a floor with this U-value must be used in the notional building. If the uninsulated U-value is less than 0.25 W/m²K it will be used to create a bespoke floor construction that will be automatically assigned to the relevant floors in the notional building.

Ground-contact U-value adjustment dialog (Adjust button)

This dialog is accessed via the Adjust button on the Functional Settings dialog for exposed floors, external walls and TSC walls which becomes active when the Ground-contact Floor/Wall box is ticked.

The dialog provides a means for adjusting the properties of the construction to make allowance for 3-dimensional heat transfer through the building element and the adjacent soil. The adjustment is a function of building geometry and a set of parameters interfaced on the dialog.

Analysis method: Either the EN-ISO 13370 standard or the ASHRAE F-factor (Heat Loss Coefficient) method may be as the basis of the adjustments. This choice affects the input parameters presented on the dialog.

Parameters and options applying to both methods:

Set ground-contact floor plans: This button invokes the Ground-contact U-value adjustment dialog, which allows the following parameters relating to the building geometry to be set either manually or automatically for each level where a floor is in contact with the ground (use Add level, Insert Level and Delete level):

- **Level**: Assigned automatically to 0, -1, ...
- **Depth below ground**: The depth of the floor surface below ground level
- **Floor plan area**: The total area of ground-contact floor at this level
- **Floorplan exposed perimeter**: The exposed perimeter length of the floorplan at this level
- **Characteristic dimension**: A property of the floor geometry with the dimensions of length, derived automatically as

\[2 \times \text{Floorplan area} / \text{Floorplan exposed perimeter}\]

Update from building geometry: This button automatically updates the above parameters from the current building geometry.

- **Level**: Select the level (0, -1, ...) to which the construction is to be applied.
- **Characteristic dimension, Floor depth, Exposed floor perimeter, Floor area**: The values of these parameters are copied from the dialog Set ground-contact floor plans. In the case of the first two the values may be overridden after ticking the adjacent box Override for U-value calc?

Note on F-factor method. In the case of floors, the adjusted U-value is calculated to give the correct overall heat transfer coefficient when applied to the entire ground-contact floor area. Users applying the F-factor method may wish to apportion the heat transfer to perimeter rooms only. In this case the Characteristic dimension for the perimeter room floor construction should be calculated as
and a construction with a low U-value should be assigned to non-perimeter rooms.

**Apply adjustment?** Tick this box to apply the adjustment to the construction layers on exit from the dialog. An insulating layer will then be added to the construction beneath the soil layer (or if such a layer is already present it will be modified) to achieve the appropriate adjusted U-value.

Parameters applying to EN-ISO 13370 method:

- **Ground conductivity**: The conductivity of the soil. If **Copy from layer data?** is ticked the value is taken from the soil layer of the construction (when present).
- **Floor resistance**: The combined thermal resistance of the floor layers, excluding the U-value adjustment layer (when present) and any other layers with a conductivity greater than 0.2 W/mK. If **Copy from layer data?** is ticked the value is derived automatically from the properties of the construction layers.
- **External wall thickness**: The thickness of the external walls of ground-contact spaces.
- **Edge insulation type**: The type of edge insulation (Horizontal, Vertical or None).
- **Edge insulation width, thickness & conductivity**: The width, thickness and conductivity of the edge insulation (where present).

Parameters applying to ASHRAE F-factor (Heat Loss Coefficient) method:

- **F-factor**: The F-factor appropriate to the type of external wall construction. Suitable values are provided in the ASHRAE Handbook – Fundamentals, Chapter 18.

**Regulations Tab**

This tab is only displayed if you have a licence for a relevant compliance application such as VE Compliance Part L2, Title 24 California or ASHRAE 90.1 PRM. The parameters set here are only required for special purposes (e.g. categorisation of the Construction element) in the relevant regulation.

- **Thermal bridging coefficient**: Part L2 (2006) requires an allowance to be made for non-repeating thermal bridging. In the <VE> implementation this is handled via a coefficient expressing this component of heat loss as a multiple of element area. This can be thought of as an addition to element U-value. The default value of 0.035 W/m²K represents a typical value for office spaces built to the standards of the Robust construction details defined in IP 17/01. In the notional building, thermal bridging coefficients are set to standard values laid down in the NCM methodology document.

- **Metal cladding**: Constructions can be identified as metal clad. This is used for thermal bridging in SBEM compliance testing.

- **Curtain wall**: If the construction belongs to the Wall category it can be identified as a curtain wall. This is used for UK Building Regulations compliance testing.

- **Standard**: Generic, UK NCM, etc.

- **Retain in notional/reference building**: If the construction belongs to the Partition or Floor/ceiling categories this additional parameter must be set for UK Building Regulations compliance testing.

- **Door Type**: If the construction belongs to the Door category an additional parameter must be set for UK Building Regulations compliance testing (U-values checks).

Select from the following options

- **Personnel door**: standard door.
• **Vehicle access or similar large door**: a category of door to which special rules, including more stringent U-value requirements, are applied in the Building Regulations.

• **Wall or roof element**: select this option if you have used a door to represent elements of a wall or roof. This will place these elements in the correct category for Building Regulations purposes.

• **Smoke vent**: select this option for a roof ventilator.

• **High usage entrance door**: select this option to represent the entrance to a building with a high throughput of people (e.g. shopping centre, airport).

• **Curtain Wall**: select this option if the door is representing a curtain wall (opaque) panel in the model.

**Frame Tab**

This tab is only displayed if the construction belongs to the **Door** category.

**LCA frame materials**: The assigned list of special LCA frame materials is displayed. The **Edit** button displays a dialog allowing you to edit this list of special LCA frame materials to your construction. This is only relevant to users of the cost planning and life cycle software where the datasets include some special materials with quantity method set to length instead of area. These are used in LCA to account for the environmental impact or costs of frame materials.

**Construction Layers (Outside to Inside) grid**

The construction may consist of up to 10 homogeneous layers, which are listed in order from outside to inside. With the exception of air gaps, each layer has a thickness and a material. The material has a set of properties which are stored in the Project Materials database, but which may be edited within the layer. Any new materials created by edits of this kind will be added to the list of Project Materials. Air gaps (which can include cavities filled with other gases such as argon) are assigned a thermal resistance in place of a material.

**Material**: the id and description of the material composing the layer, or alternatively ‘Cavity’.

**Thickness**: the thickness of the layer.

**Conductivity**: the thermal conductivity of the material. Values for commonly used building materials are listed in Table 6 in the Apache Tables document and in CIBSE Guide A.

**Density**: the density of the material. Values for commonly used building materials are listed in Table 6 in the Apache Tables document and in CIBSE Guide A.

**Specific heat capacity**: the specific heat capacity of the material. Values for commonly used building materials are listed in Table 6 in the Apache Tables document and in CIBSE Guide A.

**Resistance**: (cavity only) the thermal resistance of the cavity or air gap, taking account of both convection and radiation across the gap.

**Vapour Resistivity**: the vapour resistivity of the material or air gap. This field is blank for many materials, but a value must be supplied before condensation analysis is carried out. Values for commonly used building materials are listed in Table 16 in the Apache Tables document.

**Category**: the material category from the materials database.

**Layer buttons**

The following buttons, which are mostly also available as context menu (right-click) options, are provided for tasks related to layer editing:

**Copy**: copies the properties of the selected layer to the clipboard. This is the same as **Copy Layer** on the context menu.
Paste: copies the material properties (but not the layer thickness) from the clipboard to the selected layer. The contents of the clipboard may have been copied from another layer, from a layer of a system construction or from a project or system material. This is the same as Paste Layer on the context menu.

Cavity: creates an air gap adjacent to and on the outer side of the selected layer. This is the same as Insert Cavity on the context menu.

Insert: inserts a layer adjacent to the selected layer on its outer side and assigns it the material properties stored in the clipboard. If the clipboard contains a construction layer, the new layer is also assigned the copied thickness. This is the same as Insert Layer on the context menu.

Add: adds a layer to the inside surface of the construction and assigns it the material properties stored in the clipboard. If the clipboard contains a construction layer, the new layer is also assigned the copied thickness. This is the same as Add Layer on the context menu.

Delete: deletes the selected layer. This is the same as Delete Layer on the context menu.

Flip: reverses the order of the layers. There is no equivalent option on the context menu.

Composite: converts a non-composite layer to a composite layer with two sub-layers, or a composite layer with two sub-layers to a composite layer with three sub-layers. Sub-layers initially use “in-line” data instead of real materials, but they can be “promoted” to using real materials. There is no equivalent option on the context menu.

Composite layers are generated in certain ASHRAE wizard-generated constructions. However these do not normally require subsequent editing. See Composite layers for details.

Composite layers are also used in the cost planning and life cycle software where sub-layers using real materials can be used to increase the accuracy of material usage. This software imposes certain rules on allowed combinations of BRE materials in a composite layer; after any such edit any rule violations will be checked and if necessary a validation window will display showing the rule violations and inviting you to fix them or enter a justification for the edit. See BRE materials for details.

NB A composite layer cannot be turned back into a non-composite layer – you would have to delete the layer and re-add it.

Additional context menu options

U-Value adjustment: Sets the selected layer as the layer to be adjusted in the U-value adjustment calculation, and displays a dialog allowing you to select whether to adjust conductivity or thickness to achieve the desired U-value.

Make real material (only available when you right-click on a composite layer sub-layer): displays a sub-menu where you can select from project, system or library materials, to “promote” the “in-line” data for the selected sub-layer into a reference to a real material. See Composite layers for details.

NB A sub-layer using a real material cannot be turned back into a sub-layer using “in-line” data.

Materials buttons

System Materials...: display the materials used in the system database, with the option of copying them into the construction. See System Materials for details.

Project Materials...: display the materials in the project database, with the option of copying them into the construction. See Project Materials for details.

NB Library materials cannot be viewed from a button on this dialog.
Calculation buttons

Two further buttons perform analysis functions on the selected construction:

*Condensation analysis*: carries out an analysis of condensation risk for the construction under given temperature and humidity conditions. See *Condensation Analysis* for details.

*Derived parameters*: displays, in a separate window, a set of derived parameters for the selected construction. These include U-values and parameters relating to the CIBSE admittance procedure. The derived parameters will be dynamically updated as the construction is edited. See *Derived Parameters* for details.

OK/Cancel buttons

The construction editing session is completed by clicking on either the OK or the Cancel button:

*OK*: Exits the opaque construction dialog and keeps any changes.

*Cancel*: Exits the opaque construction dialog and discards any changes.
5 Editing a Glazed Project Construction

This dialog appears when a glazed project construction is selected for editing by means of a double click or the Edit selected construction icon. It displays the properties of a glazed construction and allows them to be edited. The dialog includes tabbed sections, as shown below:

![Figure 8 Glazed construction](image)

All transparent constructions of whatever material, including transparent doors, should be defined as glazed constructions.

The fields and buttons displayed on the dialog are described below. Fields appearing on a white background are editable. When setting this data it is important to understand the conventions applied to the orientation of constructions and the ordering of their layers, which are described in the section headed *Construction orientation*.

**Description**: a description of the construction in words.

**ID**: a unique identifier assigned to the construction when it is created.

**External**: Shows the colour used by Radiance for the internal surface when this construction is assigned. When clicked, displays a colour picker allowing the assigned colour to be changed.

**Internal**: Shows the colour used by Radiance for the internal surface when this construction is assigned. When clicked, displays a colour picker allowing the assigned colour to be changed.

**Performance**: The type of U-value calculation used (CIBSE, EN-ISO or ASHRAE). Note that the EN-ISO method does not take account of the entered values for emissivity, surface resistance or wind exposure.

**Net U-value (including frame)**: the net U-value of the construction, calculated as an average of the centre-pane and frame U-values, weighted according to the frame percentage. Calculated using the selected method (CIBSE, EN-ISO or ASHRAE).
**U-value (glass only):** the centre-pane U-value of the construction, calculated using the selected method (CIBSE, EN-ISO or ASHRAE).

**CIBSE shading coefficient:** The ratio of the instantaneous heat gain at normal incidence transmitted by a particular glass/blind combination to that transmitted by a reference glass, usually 3 mm or 4 mm thick clear glass. See CIBSE Guide A section5.

**Net R-value:** total thermal resistance of all the glazed layers (including surface resistances).

**g-value (BS EN 410):** the solar transmittance (between 0 and 1)

**Visible light normal transmittance:** the proportion of normally incident visible light that is transmitted by the glazed portion of the construction.

**Surfaces Tab**

*Outside surface:*

**Emissivity:** the emissivity of the outside surface of the construction. If the construction involves low-emissivity coatings these are usually applied to surfaces facing into an air gap, and do not therefore affect the outside or inside surface emissivities. If the outer pane has an emissivity for its outside surface, this sets the construction outside surface emissivity automatically.

**Resistance:** the thermal resistance between the outside surface and its environment. This is the reciprocal of the outside heat transfer coefficient, which is made up of convective and radiative components. Ticking the default box displays a standard value determined from the construction category and, in the case of external adjacency, the Wind exposure. The displayed default value is used in the ApacheCalc programs. In ApacheSim it is replaced by algorithms that take account of the changing heat transfer conditions at every time step. If the default box is not ticked, the entered value is used by all programs.

*Inside surface:*

**Emissivity:** the emissivity of the inside surface of the construction. If the construction involves low-emissivity coatings these are usually applied to surfaces facing into an air gap, and do not therefore affect the outside or inside surface emissivities. If the inner pane has an emissivity for its inside surface, this sets the construction inside surface emissivity automatically.

**Resistance:** the thermal resistance between the inside surface and its environment. This is the reciprocal of the inside heat transfer coefficient, which is made up of convective and radiative components. Ticking the default box displays a standard value determined from the construction category. The displayed default value is used in the ApacheCalc programs. In ApacheSim it is replaced by algorithms dependent on simulation options. If the default box is not ticked, the entered value is used by all programs.

**Frame Tab**

**Percentage:** The material percentage of the glazing element taken up by the frame. This is used in solar calculations and affects net U-value.

**U-value:** The U-value of this window including the frame, calculated using the selected method (CIBSE, EN-ISO or ASHRAE). U-values for various types of window frame and sash are given in CIBSE Guide A Table 3.25 and are based on data given in BS EN ISO 10077-1.

**Absorptance:** The absorptance of this frame. Absorptance is defined as the ratio of the amount of radiation absorbed by a surface to the amount of radiation incident upon it. Standardised values can be assumed as follows:

- dark coloured surface = 0.9
- light coloured surface = 0.5.
**Resistance:** The resistance of this frame. The resistance is expressed in m²K/W and is the reciprocal of thermal conductance.

**Outside surface area ratio:** The outside surface area ratio of this frame. This is the material percentage of the outside surface taken up by the frame.

**Inside surface area ratio:** The inside surface area ratio of this frame. This is the material percentage of the inside surface taken up by the frame.

**Type:** The type of frame material selected from a list. The list includes softwood, hardwood, steel, aluminium, PVC and metal and this is used in UK Part L compliance testing.

**LCA frame materials:** The assigned list of special LCA frame materials is displayed. The Edit button displays a dialog allowing you to edit this list of special LCA frame materials to your construction. This is only relevant to users of the cost planning and life cycle software where the datasets include some special materials with quantity method set to length instead of area. These are used in LCA to account for the environmental impact or costs of frame materials.

**Shading Device Tab**

**Local shade:** Click on the question mark to specify a local shading device. See Shading devices for details.

**External shade:** Click on the question mark to specify an external shading device (shutter or louvre). See Shading devices for details.

**Internal shade:** Click on the question mark to specify an internal shading device (curtain or blind). See Shading devices for details.

**Regulations Tab**

This tab is only displayed if you have a licence for a relevant compliance application such as VE Compliance Part L2, Title 24 California or ASHRAE 90.1 PRM. The parameters set here are only required for special purposes (e.g. categorisation of the Construction element) in the relevant regulation.

**Data Source:** Generic, NCM, etc.

**Surface area ratio:** The surface area ratio of this window. This is the “developed area to projected area” ratio for the window or rooflight. The developed area is the total area of the glass plus the frame, and the projected area is the area of the opening in the wall/roof. Therefore, for domed or conical rooflights, for example, this ratio would be larger than 1. It cannot have a value which is less than 1.

**Thermal bridging coefficient:** Part L2 requires an allowance to be made for non-repeating thermal bridging. In the VE implementation this is handled via a coefficient expressing this component of heat loss as a multiple of element area. This can be thought of as an addition to element U-value. The default value is 10% of the element u-value. In the notional building, thermal bridging coefficients are set to standard values laid down in the NCM methodology document.

**Window Type:** The Window type option allows the user to mark the element as a glazed door for UK Building regulations u-value check categorisation or as a roof monitor for the calculation of correct ASHRAE 90.1 PRM daylight control zones.

Select from the following options

- **Window:** The default value for a glazed element, select this for a window or rooflight
- **Personnel door:** a standard glazed door.
• **Vehicle access or similar large door**: a category of glazed door to which special rules, including more stringent U-value requirements, are applied in the Building Regulations.

• **High usage entrance door**: select this option to represent a glazed entrance to a building with a high throughput of people (e.g. shopping centre, airport).

• **Roof Monitor**: select this to mark the window as a roof monitor, this is used for ASHRAE 90.1 PRM 2013 Navigator assignment of roof monitors to apply special daylight zone rules when calculating daylight zones for lighting controls.

---

**BFRC Data Values**: tick if you wish to add values as defined under the conventions of the British Fenestration Rating Council. If so, enter g-value and Light transmittance.

**Display Window?**: tick if this is a display window.

---

**UK Dwellings Tab**

These parameters are required only for dwellings under UK Building Regulations compliance testing.

**Glazing type**: select a glazing type.

**% Sky blocked**: select a category from the list to indicate the degree of shading.

---

**Electrochromic Glazing Tab**

These parameters determine the controller for an electrochromic glazed construction. This tab is only displayed if the glazed construction contains an Electrochromic layer.

**Control Profile**: Select a modulating profile to determine when the electrochromic glazing is active. When inactive (profile value of 0), the pane will be in its clear state. When active (profile value of 1), the pane will interpolate between the specified clear and dark states based on the value of its control function. If the profile takes a value between 0 and 1, then the control function will be weighted by the control profile.

**Control Function**: The control function is a formula, much like those used in formula profiles. However, the control function is different in that it stands on its own; it is not attached to a profile. When a simulation runs and the electrochromic glazed element is active, the control function (whose value, once evaluated, is clamped between 0 and 1) determines the tint of the glazing by linearly interpolating between 0 (clear) and 1 (dark). The variables that may be used in the control function are the same as those in any other function, with the addition of the incident solar irradiance variable, \(ii\), as noted in the ApPro documentation.

The default formula in Metric is \((ii - 400.0)/400.0\) (with an equivalent default for projects using imperial units). This linearly interpolates between 0 at 400W/m\(^2\) and 1 at 800W/m\(^2\). The syntax of the formula follows that used in ApPro for formula profiles – an indicator to the right of the text box will show whether the formula is valid (✔️) or invalid (❌). If an invalid formula is entered, the construction window’s OK button is disabled.

**Metric / Imperial**: These buttons set the units of the control function variables. When the formula is evaluated, the variables are replaced by their values in whichever system of units is specified. However, switching between Metric and IP does not convert constants to the specified units. As an example, consider the default metric formula of \((ii - 400.0)/400.0\). At \(ii = 800W/m^2\), it evaluates to 1, if the formula is evaluated as metric. However, if it is evaluated as IP, it evaluates to -0.37 (clamped to 0 during simulation) because 800W/m\(^2\) is the same as 253.6Btu/(h.ft\(^2\)). It is important, therefore, to consider the physical dimension of constants in an expression and convert them accordingly.
?: This button opens the ApPro user guide at the formula syntax section, for guidance on possible values that could be used for the Control Function formula.

The control signal for the layer is determined by multiplying the Control Profile by the Control Function – this will allow the true state of the Electrochromic Layer to be determined during simulation (the value will be appropriately interpolated between fully transparent and fully opaque).

**Construction Layers (Outside to Inside) grid**

The construction may consist of up to 4 glazing panes separated by air gaps. The panes are listed in order from outside to inside. With the exception of air gaps, each layer is assigned a pane type, consisting of a description and a set of optical properties describing the pane. Unlike an opaque material, a pane type describes the properties of the layer (pane) rather than the substance of which it is made. The pane properties are stored in the Project Materials database, but may be edited within the layer. Any new pane type created by edits of this kind will be added to the list of Project Materials. Cavity layers (air gaps and other gas-filled cavities) can be described in three different ways: in terms of a gas, a convection coefficient or a cavity resistance.

**Material**: the id and description of the material composing the layer, or alternatively ‘Cavity’.

**Thickness**: the thickness of the layer.

**Conductivity**: the thermal conductivity of the material. Values for commonly used building materials are listed in Table 6 in the Apache Tables document and in CIBSE Guide A.

**Angular dependence**: specifies the angular dependence of the pane’s optical properties. The options are as follows:

- ‘Fresnel’: Calculates the angular dependence using the Fresnel equations and the specified refractive index, with adjustments to cater for special coatings.
- ‘Explicit’: Explicit user-specified angular dependence (see ‘More data’).
- ‘Constant’: Optical properties are independent of incidence angle.
- ‘LBNL’: Uses standard profiles for angular dependence, as specified by Lawrence Berkeley National Laboratory.

**Gas** (optional): gas type of the cavity. If set, this is used to calculate the cavity convection coefficient.

**Convection coefficient** (optional): the convection coefficient for heat transfer across the cavity. If set (or calculated from Gas), this is used, with the adjacent pane surface emissivities, to calculate the cavity resistance.

**Resistance** (optional, air gap only): the thermal resistance of the air gap, taking account of both convection and radiation across the gap. The air gap resistance will be higher if a low-emissivity coating is applied to either of the surfaces facing into the cavity. If Cavity convection coefficient is set, it is used, with the adjacent pane surface emissivities, to calculate the cavity resistance. For guidance on setting air gap resistance and other glazing parameters, see the Hints & Tips section.

**Transmittance**: The transmittance of the pane for solar radiation at normal incidence.

**Outside reflectance**: the reflectance of the outside surface of the pane for solar radiation at normal incidence.

**Inside reflectance**: the reflectance of the inside surface of the pane for solar radiation at normal incidence.
**Refractive index:** The refractive index of the material composing the pane. Editable only if the angular dependence is set to ‘Fresnel’.

**Outside emissivity:** the emissivity of the outside surface of the pane. This is used to calculate the thermal resistance of the adjacent surface or cavity (unless this resistance has been specified explicitly).

**Inside emissivity:** the emissivity of the inside surface of the pane. This is used to calculate the thermal resistance of the adjacent surface or cavity (unless this resistance has been specified explicitly).

**Visible light specified (not currently used):** Indicates whether the pane data contains visible light parameters (which in due course will provide an alternative route to deriving the construction’s visible light transmittance).

Note: For an Electrochromic Layer, the values for Thickness, Conductivity and Angular Dependence must match on both the Clear and Dark sub-layers. When these values differ, the Electrochromic Layer will be highlighted red, the OK button on the construction window disabled and the Derived Parameters window hidden:

<table>
<thead>
<tr>
<th>Layer/Thickness</th>
<th>Value 1</th>
<th>Value 2</th>
<th>Angular Dependence</th>
<th>Value 3</th>
<th>Value 4</th>
<th>Value 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear [STD_EXW] Outer Pane</td>
<td>5.0</td>
<td>0.0047</td>
<td>Fresnel</td>
<td>0.409</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dark [STD_EXW] Outer Pane</td>
<td>6.0</td>
<td>0.0057</td>
<td>Fresnel</td>
<td>0.409</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Layer buttons**

The following buttons, some of which are also available as context menu (right-click) options, are provided for tasks related to layer editing:

**Copy:** copies the properties of the selected layer (pane) to the clipboard. This is the same as Copy Layer on the context menu.

**Paste:** copies the material properties from the clipboard to the selected layer. The contents of the clipboard may have been copied from another layer, from a layer of a system construction or from a project or system material. This is the same as Paste Layer on the context menu.

**Insert:** inserts a layer adjacent to the selected layer on its outer side and assigns it the material properties stored in the clipboard. If the clipboard contains a construction layer, the new layer is also assigned the copied thickness. This is the same as Insert Layer on the context menu.

**Add:** adds a layer to the inside surface of the construction and assigns it the material properties stored in the clipboard. If the clipboard contains a construction layer, the new layer is also assigned the copied thickness. This is the same as Add Layer on the context menu.

**Delete:** deletes the selected pane and an adjacent air gap. If the pane is enclosed within the construction the deleted air gap will be the one to its inside. This is the same as Delete Layer on the context menu.

**Flip:** reverses the order of the panes and air gaps. There is no equivalent option on the context menu. Note that the order of the sub-layers within an Electrochromic Glazing layer will not be affected – these are always displayed as the Clear state followed by the Dark state.

**Electrochromic:** transforms the selected pane into an electrochromic pane (see below). A maximum of one electrochromic pane can exist in a given construction. When an electrochromic pane exists, the Electrochromic Control tab is made available.

**More Data...:** opens the ‘Glazing material (pane)’ dialog (see below)
Electrochromic button

This button converts the selected glazing layer to be an Electrochromic glazing layer, consisting of Clear and Dark sub-layers. This button will be disabled if the construction already contains an electrochromic layer, or a cavity (air gap) layer is selected.

When the Electrochromic button is clicked, the Electrochromic Glazing tab is automatically selected and the previously selected layer material is used for both the Clear and Dark state sub-layers. The standard Paste functionality can be used to change the material assigned on either of the sub-layers.

Materials buttons

System Materials: display the materials used in the system database, with the option of copying them into the construction. See System Materials for details.

Project Materials: display the materials in the project database, with the option of copying them into the construction. See Project Materials for details.

NB Library materials cannot be viewed from a button on this dialog.

Calculation buttons

Two further buttons perform analysis functions on the selected construction:

Condensation analysis: carries out an analysis of condensation risk for the construction under given temperature and humidity conditions. See Condensation Analysis for details.

Derived parameters: displays, in a separate window, a set of derived parameters for the selected construction. These include U-values and optical properties. The derived parameters will be dynamically updated as the construction is edited. See Derived Parameters for details.

OK/Cancel buttons

The glazed construction editing session is completed by clicking on either the OK or the Cancel button:

OK: exits the glazed construction dialog and keeps any changes.

Cancel: exits the glazed construction dialog and discards any changes.

More Data... button

When the button ‘More Data...’ is clicked the dialog in Fig 11 appears, displaying data for the selected layer. These variables include those which appear in the ‘Glazed construction’ dialog.
Thermo-Optical properties grid

These properties, with the exception of the last three, are also displayed on the ‘Glazing material (pane)’ dialog.

Thickness: the thickness of the layer.

Conductivity: the thermal conductivity of the material. Values for commonly used building materials are listed in Table 6 in the Apache Tables document and in CIBSE Guide A.

Outside emissivity: the emissivity of the outside surface of the pane. This is used to calculate the thermal resistance of the adjacent surface or cavity (unless this resistance has been specified explicitly).

Inside emissivity: the emissivity of the inside surface of the pane. This is used to calculate the thermal resistance of the adjacent surface or cavity (unless this resistance has been specified explicitly).

Angular dependence: pane angular dependence behaviour. The default value is set to ‘Fresnel’, the other options are: ‘Explicit’, ‘Constant’ and ‘LBNL’.

Refractive index: The refractive index of the material composing the pane. Editable only if the angular dependence is set to ‘Fresnel’.

Transmittance: The transmittance of the pane for solar radiation at normal incidence.

Outside reflectance: the reflectance of the outside surface of the pane for solar radiation at normal incidence.

Inside reflectance: the reflectance of the inside surface of the pane for solar radiation at normal incidence.

Visible Transmittance (not currently used): The transmittance of the pane for visible solar radiation at normal incidence.

Outside visible reflectance (not currently used): the reflectance of the outside surface of the pane for visible solar radiation at normal incidence.

Inside visible reflectance (not currently used): the reflectance of the inside surface of the pane for visible solar radiation at normal incidence.
Optical properties – angular dependence grid

Solar spectrum

When ‘Angular dependence’ is set to ‘Explicit’ this grid allows the specification of explicit values for solar transmittance (tau), outside reflectance (rho_o) and inside reflectance (rho_i) for a range of incidence angles (0°-90°). For other settings of ‘Angular dependence’ only the normal incidence value can be edited (these being duplicates of the values appearing in the ‘Thermo-optical properties’ grid). The values must be between 0 to 1.0 and the sum of transmittance and inside reflectance or transmittance or outside reflectance cannot exceed 1.0.

Visible spectrum (not currently used)

When ‘Angular dependence’ is set to ‘Explicit’ this grid allows the specification of explicit values for visible light transmittance (tau), outside reflectance (rho_o) and inside reflectance (rho_i) for a range of incidence angles (0°-90°). For other settings of ‘Angular dependence’ only the normal incidence value can be edited (these being duplicates of the values appearing in the ‘Thermo-optical properties’ grid). All the values must be between 0 to 1.0 and the sum of transmittance and inside reflectance or transmittance or outside reflectance cannot exceed 1.0.

Radiance properties grid (not currently used)

For more information see: ‘Radiance’ manual.

Surface type: ‘plastic’, ‘metal’, ‘glass’ or ‘trans’.

Roughness: the roughness of the pane surface. Roughness range value 0.0-1.0.

Overall transmissivity: the ratio of the directly transmitted light after passing through the pane to the amount of light that would have passed the same distance through a vacuum.

Transmitted specularity: is the ratio between the reflected light by specular mechanisms and the diffuse light.

Specularity: the amount of light reflected by specular mechanisms (basically how shiny a surface is).

Red transmittance: pane transmittance in the Red spectrum.

Green transmittance: pane transmittance in the Green spectrum.

Blue transmittance: pane transmittance in the Blue spectrum.

Red reflectance: pane reflectance in the Red spectrum.

Green reflectance: pane reflectance in the Green spectrum.

Blue reflectance: pane reflectance in the Blue spectrum.

Red transmissivity: pane transmissivity in the Red spectrum.

Green transmissivity: pane transmissivity in the Green spectrum.

Blue transmissivity: pane transmissivity in the Blue spectrum.

Miscellaneous properties grid

For more information see: ‘Life Cycle Analysis’ (LCA) manual.

Service life (years): expected pane service life.

Site wastage %: How much wastage is produced when installing.

Adjust factor: to account for instances where adjustment is required e.g. overlapping roof slates.
BRE material #: read only – unique BRE id used when calculating the LCA.

BRE category 1 ID: read only – used when constructing composite constructions.

BRE category 2 ID: read only – used when constructing composite constructions.

Last edited: date when this material was last edited.

Info/Notes: user notes on the pane.

Quantity method: default value ‘Area’.

Overall mass: gives the kg/m value of the material.

Generic/Certified: Generic or certified – generic is a BRE generic construction, certified is generally a specific construction (see description of construction for more details).
6 Construction orientation

The orientation of both opaque and glazed constructions is important thermally and is governed by the following rules.

1. The layers of a construction are listed in order from outside to inside.

2. For Roofs, External walls, Ground/Exposed Floors, External Windows and Rooflights, the outside of the construction faces the external environment (or in the case of a Ground Floor the ground).

3. Internal Ceiling/Floors are defined as ceilings, so the outside of the construction is the upper side. Note that as a consequence, these constructions are displayed in the reverse orientation to ground or exposed floors.

4. The orientation of Internal Partitions and Internal Windows depends on the particular instance in the building, and is determined from the relative ordering of the adjacent spaces in the room browser. The convention is that the inside of the Internal Partition or Window, as defined in the Constructions Database, is the side facing the space that appears first on the browser.

5. Doors are treated in the same way as external constructions or internal partitions, depending on whether they have internal or external adjacency.
7 Project materials

The project materials dialog provides a list of materials used in the project. It is accessed via the Project materials option on the View menu, or alternatively from buttons on the construction editing dialogs.

![Project materials dialog with extra section hidden](image)

This dialog has an extra section which is only of interest to the LCA or LCC software (see BRE materials and Cost planning and lifecycle software for details):
Materials in the database are organised in categories such as Concretes, Insulating Materials and Glass. The Material category is selected from a list. Two new categories are added, Floor finishes and Suspended ceilings, of interest only to the cost planning and life cycle software. You can also choose Show all opaque categories if you prefer to see materials from all opaque categories together (Glass is not included because the columns are different for Glass).

The materials in the chosen category, together with their properties, are displayed in a grid with columns for each property. The materials may be sorted according to any of their properties. For example to sort concretes by density click on the Density column. The first click arranges the materials in ascending order, the second in descending order.

Icons on the toolbar provide the following options operating on the selected construction:

- **Copy material**: Copies the selected material to the clipboard, ready for pasting into a project construction.

- **Show material references**: Displays the Material References dialog, with a list of project constructions referencing the selected material:
Compact materials database: Compact the materials database will remove duplicate materials.

Delete material: Delete the material from the project material database.

NB When the Project materials dialog is opened from the Project materials button in the Project construction dialog (with a layer row selected), the Project materials dialog selects the appropriate material category and material for your convenience.

If a material has been edited in the Materials dialog and you move on to another material or close the dialog, a check is made to see how many constructions reference that material. If only one construction references the material, the material is updated with the same ID. If more than one construction references the material, a dialog is displayed where you can select which constructions are to be updated to use the new material:
If you select all of them, again the material is updated with the same ID. If you select some but not all, a new material is created with a new, automatically generated, ID, and only the selected constructions will reference the new ID. If you select none, you are prompted that if you continue the changes will be discarded:

Figure 16 Confirmation dialog

Press Yes to discard the changes or No to reselect constructions to update.
8 System or library constructions

The system constructions database is a central store of constructions available for copying into projects. Materials and glazing pane types in the system constructions may also be copied. This database is accessed via the System constructions option on the View menu. You can keep the database open while you work on project constructions.

![System constructions dialog](image)

Figure 17 System constructions dialog

The Library constructions dialog is identical apart from the caption which displays the name of the library (e.g. “Library constructions (non-editable) [IMPACT_CMP_Dataset_V15]”). The library databases are accessed via the menu options ending in “ constructions...” under the Library (constructions and materials) option on the View menu.

This dialog works in a similar way to the main Project constructions dialog and organises the constructions using the same classes and categories. The main difference is that, unlike project constructions, system constructions may not be edited, only viewed and copied. Therefore many functions are unavailable (not shown, or disabled if shown) and a Copy construction to project option is now enabled.
9 System or library materials

The system materials database is a central store of materials and glazing pane types available for copying into projects. This database is accessed via the System materials option on the View menu, or alternatively from buttons on the construction editing dialogs. You can keep the database open while you work on project constructions.

![System materials dialog](image)

**Figure 18 System materials dialog**

The Library materials dialog is identical apart from the caption which displays the name of the library (e.g. “Library materials (non-editable) [IMPACT_CMP_Dataset_V15]”). The library databases are accessed via the menu options ending in “materials...” under the Library (constructions and materials) option on the View menu.

Materials in the database are organised in categories such as Concretes, Insulating Materials and Glass. The Material Category is selected from a list.

This dialog works in a similar way to the main Project materials dialog and organises the materials using the same categories. The main difference is that, unlike project materials, system materials may not be edited, only viewed and copied. Therefore many functions are unavailable (not shown, or disabled if shown) and a Copy material to project option is now enabled.
10 Shading Devices

Shading devices of three kinds – internal, external and local – may be attached to glazed constructions. This is a quick way to specify shading features to all instances of a glazing construction. The results of the shading calculations performed for these shading devices are combined with those carried out by SunCast.

The three types of shading device are suitable for representing the following types of shading:

- **Internal**: curtains, blinds.
- **External**: shutters, louvres, brise soleils.
- **Local**: side-fins, overhangs, balconies, window recesses.

10.1.1 Internal Shading

The input dialog window for an internal shading device is shown below. Descriptions of the data fields are given below.

![Internal Shading Device dialog](image)

**Figure 19 Internal Shading Device dialog**

10.1.1.1 Device:

Selecting *Curtains* or *Blinds* activates the device and allows the parameters to be edited. No distinction is made between curtains and blinds in terms of the performance of the device.

10.1.1.2 Percentage Profile Group:

A percentage profile specifying the timing of the blind operation. Percentage values greater than 50% are interpreted as ‘on’ and other values as ‘off’. When the profile is on,
the device operates (i.e. is lowered into position). When the profile is off, or set to 'none', the device is controlled by incident solar radiation, as specified by the following two parameters.

10.1.1.3 Incident Radiation to Lower Device:
This parameter comes into play when the profile is off. The shading device starts operating (i.e. is lowered into position) when the total incident solar radiation flux rises through this value. If Incident Radiation to Raise Device and Incident Radiation to Lower Device are both set to zero the device is assumed to operate only according to the timed operation profile and its operation is not affected by solar radiation.

10.1.1.4 Incident Radiation to Raise Device:
This parameter comes into play when the profile is off. The shading device stops operating (i.e. is raised) when the intensity of total incident solar radiation falls below this value. This value must be less than or equal to the Incident Radiation to Lower Device. For incident radiation fluxes between the two thresholds the blind remains in its previous state. If Incident Radiation to Raise Device and Incident Radiation to Lower Device are both set to zero the device is assumed to operate only according to the timed operation profile and its operation is not affected by solar radiation.

10.1.1.5 Night-time Resistance:
The additional thermal resistance (if any) associated with the device when it is in operation at night (taken to be when the sun is below the horizon). This parameter allows you to make allowance for the night-time closing of curtains or blinds.
A value of zero is appropriate in most cases. Net curtains and most types of blind have minimal insulation effect on the glazing. They can therefore be ignored for most applications. However, the effect of heavyweight curtains and blinds should be included.

10.1.1.6 Daytime Resistance:
The additional thermal resistance (if any) associated with the device when it is in operation during the day (taken to be when the sun is above the horizon). This extra resistance affects not only the U-value, but also the retransmitted component of absorbed solar radiation.
A value of zero is appropriate in most cases. Net curtains and most types of blind have minimal insulation effect on the glazing. Their thermal effect can therefore be ignored for most applications. However, the effect of heavyweight curtains and blinds should be included.

10.1.1.7 Shading Coefficient:
Blinds and curtains reduce solar penetration into the space by reflecting and absorbing short-wave solar radiation. A proportion of the absorbed heat (sometimes called re-transmitted heat) is transferred into the room by convection and long-wave radiation.
The shading coefficient specifies the degree to which the blind reduces the short-wave component of room solar gain that passes through the glazing panes. A value of 1 means no shading and a value of 0 perfect shading. Typical values are listed in Table 8 of the Apache Tables document. The internal blind is not considered to affect the long wave radiation and convective heat transfer from the glazing to the room.
If the solar transmittance (T) and absorptance (A) are known for the blind, values for the shading coefficient (SC) and short-wave radiant fraction (SWRF) can be obtained using

\[ SC = T + 0.87 \times A \]
\[ SWRF = T / SC \]
These formulae apply to a blind consisting of a single sheet of material, such as a roller blind or a closed slatted blind. They can be applied to open or partially open slatted blinds.
if an allowance is made in the $T$ and $A$ values for inter-reflection between the slats.

10.1.1.8 Short-Wave Radiant Fraction:

The short-wave radiant fraction specifies the proportion of the room heat gain associated with the blind that passes through it as short-wave radiation. Typical values are listed in Table 8 in the Apache Tables document. A method for deriving values from blind properties is described under Shading Coefficient.

10.1.1.9 Building Regulations L1:

Used for defining local shading in conjunction with Part L1 for dwellings. See the SAP 2005 document for more details on these settings in relation to overheating.

10.1.2 External Shading

The input dialog window for an external shading device such as a shutter, louvre or brise soleil is shown below. Descriptions of the data fields are given below.

![External Shading Device dialog](Figure 20 External Shading Device dialog)

10.1.2.1 Device:

Selecting Shutters or Louvres activates the device and allows the parameters to be edited. No distinction is made between shutters and louvres in terms of the performance of the device.

10.1.2.2 Percentage Profile Group:

A percentage profile specifying the timing of the operation of the shade. Percentage values greater than 50% are interpreted as ‘on’ and other values as ‘off’. When the profile is on, the device operates (i.e. is lowered into position). When the profile is off, or set to ‘none’, the device is controlled by incident solar radiation, as specified by the following two parameters.
10.1.2.3 Incident Radiation to Lower Device:
This parameter comes into play when the profile is off. The shading device starts operating (i.e. is lowered into position) when the total incident solar radiation flux rises through this value. If Incident Radiation to Raise Device and Incident Radiation to Lower Device are both set to zero the device is assumed to operate only according to the timed operation profile and its operation is not affected by solar radiation.

10.1.2.4 Incident Radiation to Raise Device:
This parameter comes into play when the profile is off. The shading device stops operating (i.e. is raised) when the intensity of total incident solar radiation falls below this value. This value must be less than or equal to the Incident Radiation to Lower Device. For incident radiation fluxes between the two thresholds the blind remains in its previous state. If Incident Radiation to Raise Device and Incident Radiation to Lower Device are both set to zero the device is assumed to operate only according to the timed operation profile and its operation is not affected by solar radiation.

10.1.2.5 Night-time Resistance:
The additional thermal resistance (if any) associated with the device when it is in operation at night (taken to be when the sun is below the horizon). This parameter allows you to make allowance for the night-time closing of shutters. A value of zero is appropriate in most cases.

10.1.2.6 Daytime Resistance:
The additional thermal resistance (if any) associated with the device when it is in operation during the day (taken to be when the sun is above the horizon). This extra resistance affects not only the U-value, but also the retransmitted component of absorbed solar radiation. A value of zero is appropriate in most cases.

10.1.2.7 Ground diffuse transmission factor:
The degree to which the ground is shaded by the device as viewed from the glazing construction. This affects the amount of diffuse ground-scattered solar radiation incident on the window. Ticking the Calculate check box sets a default value of 1.

10.1.2.8 Sky diffuse transmission factor:
The degree to which the sky is shaded by the device as viewed from the window. This affects the amount of diffuse solar radiation incident on the window from the sky. Ticking the Calculate calculates a value for this parameter as a suitably weighted average of the transmission factors for direct solar radiation.

10.1.2.9 Transmission Factors at 15 degree increments:
Values of the transmittance of the shading device for direct solar radiation, at 15 degree angular increments. The angle in question is the solar altitude measured in a vertical plane perpendicular to the glazing construction.

10.1.3 Local Shading
The input dialog window for local shading features such as projections and window recesses is shown below. Descriptions of the data fields are given below.
10.1.3.1 Device:

Selecting Projections or Window Recesses activates the device and allows the parameters to be edited. No distinction is made between projections and window recesses in terms of the performance of the device. Enter the value 0 for parameters relating to any shading features that are not present.

10.1.3.2 Window width:

The width of the windows to which the construction is to be assigned. The shading calculations will only be correct if applied to a rectangular window of the given dimensions.

10.1.3.3 Window height:

The height (top to bottom) of the windows to which the construction is to be applied. The shading calculations will only be correct if applied to a rectangular window of the given dimensions.

10.1.3.4 Balcony projection:

If there is a balcony, enter the distance it projects from the plane of the window.

10.1.3.5 Balcony height:

The height of the top edge of the balcony measured from the lower edge of the window.

10.1.3.6 Overhang projection:

If there is an overhang or recess soffit, enter the distance it projects from the plane of the window.

10.1.3.7 Overhang offset:

The distance between the overhang and the top of the window.

10.1.3.8 Left fin projection:

If there is a left side-fin or a left wall of a window recess (as viewed from the outside), enter the distance it projects from the plane of the window.
10.1.3.9 **Left fin offset:**
   The distance between the left fin or left recess wall from the adjacent window edge.

10.1.3.10 **Right fin projection:**
   If there is a right side-fin or a right recess wall (as viewed from the outside), enter the distance it projects from the plane of the window.

10.1.3.11 **Right fin offset:**
   The distance between the right fin or right recess wall from the adjacent window edge.

10.1.3.12 **Building Regulations L1:**
   Used for defining local shading in conjunction with Part L1 for dwellings. See the SAP 2005 document for more details on these settings in relation to overheating.
11 Derived parameters

By clicking on the Derived Parameters button on a Construction dialog or using the Derived Parameters option on the Calculations menu, you can bring up a window displaying parameters derived from the current construction’s data. These include U-values, CIBSE admittance parameters and optical properties of glazed constructions. The derived parameters are dynamically updated in response to edits made to the construction.

11.1 Derived parameters (opaque construction)

The derived parameters for an opaque construction are as follows:

Outside surface resistance: the thermal resistance between the outside surface and its environment, as set in the construction data.
Inside surface resistance: the thermal resistance between the inside surface and its environment, as set in the construction data.

Outside convective heat transfer coefficient: the convective heat transfer coefficient for the outside surface, calculated from the surface resistance and emissivity.

Inside convective heat transfer coefficient: the convective heat transfer coefficient for the inside surface, calculated from the surface resistance and emissivity.

Outside radiative heat transfer coefficient: the radiative heat transfer coefficient for the outside surface, calculated from the emissivity.

Inside radiative heat transfer coefficient: the radiative heat transfer coefficient for the inside surface, calculated from the emissivity.

CIBSE U-Value: the U-value of the construction as calculated by the CIBSE method.

EN-ISO U-Value: the U-value of the construction as calculated by the EN-ISO method.

Admittance: the CIBSE admittance of the construction, which relates inside surface heat transfer to inside environmental temperature.

Admittance time lead: the time lead associated with the admittance.

Internal admittance: (for partitions and ceilings only) the combined admittance of both surfaces of the construction, which features in CIBSE calculations for partitions contained entirely within a room.

Decrement factor: the CIBSE decrement factor, which, taken together with the admittance, relates inside surface heat transfer to outside environmental temperature.

Decrement factor time lag: the time lag associated with the decrement factor.

Surface factor: the CIBSE surface factor for the inside surface of the construction.

Internal surface factor: (for partitions and ceilings only) the combined surface factor of both surfaces of the construction, which features in CIBSE calculations for partitions contained entirely within a room.

Checkbox

Include construction properties in printed output?: adds the construction to the list of those to be printed from the main Print facility.

Buttons

Copy: copies the derived parameters to the clipboard for pasting into other applications.

Print: prints the derived parameters.

Close: closes the dialog.
11.2 Derived parameters (glazed construction)

The derived parameters for a glazed construction are as follows:

*Calculate values based on Electrochromic Clear State/Dark State*: this option is only displayed if the construction includes an Electrochromic Glazing layer – it allows you to choose whether to display the optical properties based on the clear or the dark state of the glazing (the radio controls default to “Clear State”).

*Outside surface resistance*: the thermal resistance between the outside surface and its environment, as set in the construction data.
Inside surface resistance: the thermal resistance between the inside surface and its environment, as set in the construction data.

Outside convective heat transfer coefficient: the convective heat transfer coefficient for the outside surface, calculated from the surface resistance and emissivity.

Inside convective heat transfer coefficient: the convective heat transfer coefficient for the inside surface, calculated from the surface resistance and emissivity.

Outside radiative heat transfer coefficient: the radiative heat transfer coefficient for the outside surface, calculated from the emissivity.

Inside radiative heat transfer coefficient: the radiative heat transfer coefficient for the inside surface, calculated from the emissivity.

CIBSE U-value (glass only): the centre-pane U-value of the construction as calculated by the CIBSE method.

CIBSE net U-value (including frame): the U-value as calculated by the CIBSE method with a correction applied for the effect of the frame.

EN-ISO U-value: the U-value centre-pane as calculated by the EN-ISO method.

EN-ISO net U-value (including frame): the U-value as calculated by the EN-ISO method with a correction applied for the effect of the frame.

g-value (BS EN 410): the g-value of the glazing construction as calculated by BS EN 410. This is the total solar transmittance at normal incidence under specified conditions.

g-value (BFRC): the g-value of the glazing construction as defined under the conventions of the British Fenestration Rating Council:

\[ g-value (BFRC) = 0.9 \times (1 - \text{frame fraction}) \times g-value (BS EN 410) \]

Frame occupies...: the percentage of the glazing element taken up by the frame

T(D): the short wave solar transmittance at 10 angles of incidence

T(R): the solar transmittance at 10 angles of incidence arising from absorption in the glazing construction and subsequent conduction, convection and long-wave radiation into the room.

Short-wave shading coefficient: the shading coefficient for directly transmitted short-wave solar radiation, defined as T(D)/0.87, where T(D) is the value at 0° (normal) incidence.

Long-wave shading coefficient: the shading coefficient for absorbed solar that enters the room by conduction, convection and radiation, defined as T(R)/0.87, where T(R) is the value at 0° (normal) incidence.

Total shading coefficient: the sum of the short-wave and the long-wave shading coefficients.

Checkbox

Include construction properties in printed output?: adds the construction to the list of those to be printed from the main Print facility.

Buttons

Copy: copies the derived parameters to the clipboard for pasting into other applications.

Print: prints the derived parameters.

Close: closes the dialog.
12 Condensation analysis

This facility allows you to perform a condensation analysis on the currently selected construction. It is accessed either from the Calculations menu option Condensation analysis or by a button on the construction editing dialog.

Before condensation analysis can be carried out, all layers of the construction must be assigned a vapour resistivity. You will be prompted to supply any missing values:

![Figure 24 Vapour Resistance dialog](image1)

![Figure 25 Condensation Analysis dialog](image2)
**Edit boxes (with spin buttons)**

Conditions on each side of the construction can be specified:

- **Ext. T:** The external air temperature to be used in the analysis
- **Ext. RH:** The external air relative humidity to be used in the analysis
- **Int. T:** The internal air temperature to be used in the analysis
- **Int. RH:** The internal air relative humidity to be used in the analysis

**Chart**

If condensation is predicted, a chart is displayed showing the variation of the following variables through the construction:

- **VP:** Vapour pressure
- **Dry Bulb Temp.:** Dry bulb temperature
- **Sat. VP:** Saturated vapour pressure

A blue dot indicates where condensation occurs.

**Toolbar icons**

- **Copy to clipboard:** Copy the condensation chart to the clipboard.
- **Save condensation chart:** Save the condensation chart as a bitmap file.
- **Print condensation chart:** Print the condensation chart.
- **Text representation:** Display the results in text form (with options to copy and print).
13 Hints & Tips

13.1 Manufacturers’ data

The properties of glazing panes and constructions are published by manufacturers. The salient properties for an individual pane are the solar direct transmittance, reflectance and absorptance. These values should sum to one.

When creating a glass pane type (material) the direct transmittance, reflectance and absorptance may be used directly with no modification. However, for a double glazed unit you will find that the solar radiant properties are usually given for the full unit rather than the individual layers. The properties given are typically U-value, short-wave shading coefficient and total shading coefficient. Separate U-values may be specified for the mid-pane properties and the unit as a whole, including the frame.

The procedure for matching glazing properties for a complete glazing unit is as follows:

1. For any known glazing panes (for instance 6mm clear float), assign properties from the materials database.

2. Make a guess for the properties of panes for which no specific data is available.

3. Match the manufacturer’s mid-pane U-value by suitable choice of air gap resistance. The air gap resistance includes the effect of low emissivity coatings facing into the glazing cavity. Do not adjust the CIBSE Net U-value (including frame) or the emissivities of the outside or inside surface.

4. Click on Derived Parameters to display the derived properties of the glazing and compare the shading coefficients displayed with those provided by the manufacturer. Adjust the reflectance, absorptance and transmittance of the unknown panes to match these parameters. Be careful to ensure that the sum of the reflectance, absorptance and transmittance is 1. If the manufacturer’s data is in the form of transmittances rather than shading coefficients, use the displayed values for T(D) and T(R) at 0º incidence. These transmittances are related to the shading coefficients by a factor of 0.87.

5. Adjust the CIBSE Net U-value (including frame) to match the manufacturer’s value for this parameter. This operation must be done last, as the Net U-value is automatically updated to the calculated mid-pane U-value after edits to any other parameters.
13.2 Interstitial blinds and ventilated cavities

Blinds within a glazing cavity (which may be ventilated) can be modelled in one of two ways. The example given below assumes triple glazing:

**Method 1**

The blind may be modelled by using a fourth layer of glass but assigning the properties of the blind to this pane.

Using a fourth pane of glass to model the blind. In this case, the manufacturer's blind transmittance, absorptance, reflectance data can be used to set up a glazing material. Set the refractive index to 1.0.

The manufacturers' blind transmittance of short-wave solar radiation value can be entered directly as the transmittance of the blind material.

The absorptance is calculated by reducing the absorptance of the actual blind by a factor to account for the convection of the absorbed heat by natural ventilation in the cavity.

If the ventilation is 100% effective in removing heat absorbed by the blind, enter 0.0 as the absorptance of BLIND.

If there is no ventilation enter the manufacturers’ value directly. The actual value will lie somewhere between 0 and 100% of the manufacturer’s value.

You will have to estimate the actual value to use based on the likely flow of air through the cavity and the heat removal rate from the blinds.

It is likely that the proper value to use is between 40 and 95% of the manufacturers' absorptance value.

**Method 2**

Alternatively, the outer cavity may be modelled as a separate room. In this case the blind can be modelled in the normal way, by attaching an internal shading device to the outer pane.

The double-glazed unit between the outer cavity and the room is now an internal window.

13.3 Air partitions

If a space is subdivided with the option *Remove partition* set, the partition between the spaces is automatically replaced by a hole. Holes are completely transparent to solar radiation and MacroFlo treats them as open to the passage of air. In some instances it is appropriate to adjust the MacroFlo characteristics of such an opening (as described in the MacroFlo Methods manual), and to make this possible the hole must be replaced by a window. To ensure the correct characteristics for solar and long-wave radiation exchange the window should be constructed as a single pane with the following properties:

**General**

*Outside surface emissivity:* 1.0  
*Inside surface emissivity:* 1.0  
*Frame:* 0.0

**Construction layer**

*Reflectance:* 0.0  
*Absorptance:* 0.0  
*Transmittance:* 1.0  
*Refractive index:* 1.0
13.4 Editing materials

It is possible to edit certain material properties in two places: the Construction layers grid in the Project construction dialog (Sections 4 and 5) and the dedicated Project materials dialog (Section 7).

Material changes are not synchronised between these dialogs when both are visible so making changes in both places may result in those changes being lost.

In general, it is recommended that changes to materials are made using the Materials dialog.
14 Composite layers

The Enable composite layers menu option on the main dialog allows you to be able to create composite layers in a construction layer, where a single layer is composed of 2 or 3 separate materials in given proportions. Therefore this should be enabled if you need to create constructions with composite layers.

The Composite button in the Project construction dialogs is only available if you have already enabled composite layers (see above). It converts a non-composite layer to a composite layer with two sub-layers. If it is already a composite layer with two sub-layers it adds another sub-layer, i.e. converts it to a composite layer with three sub-layers. There is a maximum of three sub-layers. Sub-layers initially use “in-line” data instead of real materials, but they can be “promoted” to using real materials.

NB Previously only one composite layer was allowed per construction. This restriction is now lifted because some constructions using BRE materials may need several composite layers.

Composite layers are generated in certain ASHRAE wizard-generated constructions. However these do not normally require subsequent editing.

Composite layers are also used in the cost planning and life cycle software where sub-layers using real materials can be used to increase the accuracy of material usage. This software imposes certain rules on allowed combinations of BRE materials in a composite layer; after any such edit any rule violations will be checked and if necessary a validation window will display showing the rule violations and inviting you to fix them or enter a justification for the edit. See BRE materials for details.
15 BRE materials

Some of the cost planning and life cycle software is used to best advantage when you use the BRE materials from the IMPACT libraries. These can be copied from the IMPACT library to your project. Often they can be used in a non-composite layer just like any other materials. However some of these materials have extra validation rules imposed:

15.1.1 Extra validation rules when editing BRE materials

Percentage change from original material

The service life, density, adjustment percentage and site wastage percentage must not differ by more than 10% from the original library material from which this project material was copied.

![Figure 26 Percentage change validation](image)

The user is allowed to enter a justification for not conforming to this rule.

Transport distance

If the transport distance has been modified compared to the original library material from which this project material was copied, the user must confirm that all future added project materials will have user entered transport distances.
The user is allowed to enter a justification for not conforming to this rule.

15.1.2 Extra validation rules when editing BRE constructions

Appropriate material

Each BRE material has an allowed construction categories list (e.g. Roof) for which it is allowed to be added as a layer. Any BRE material used in a layer (or composite sub-layer) of this construction you are editing, must include the construction’s category in its allowed construction categories list:

The user is allowed to enter a justification for not conforming to this rule.

Valid co-layer
This is the most complex validation. Some (but not all) BRE materials have a list of valid BRE Category 1 or 2 IDs required in co-layers (i.e. the other sub-layers in a composite layer). This means that each material that needs valid co-layer materials (i.e. has a list of valid BRE Category IDs) must be used in a sub-layer of a composite layer in the construction, and that the other sub-layers in the same composite layer must match all of, and only, the valid materials in that list. Several validation checks are carried out on the materials in this construction:

a. Each material that needs valid co-layer materials must be in a composite layer.
b. Each co-layer must use a real material.
c. Each co-layer material must have a valid BRE Category ID.
d. All valid co-layer material BRE Category IDs must be present in one and only one co-layer.
e. No other materials must be present in the composite layer.

![BRE validation warning](image)

Figure 29 Valid co-layer validation

The user is allowed to enter a justification for not conforming to this rule. This is particularly important as there are some combinations of co-layers that are impossible to satisfy.

BRE Category 1 and 2 IDs are shown as columns in the materials dialog. The “P” types are Category 1 IDs, and the “L” types are Category 2 IDs.

Hint – sort on the appropriate column to make it easier to search for a required co-layer material. E.g. a type “L61” is required here, so click on the column header for Category 2 ID to sort these into alphabetical order to make it easier to see materials with this Category 2 ID.

**Percent change in co-layer service life**

The service life of all BRE materials must be the same to within 10% for all co-layers in each composite layer:
The user is allowed to enter a justification for not conforming to this rule. Again, the contents of the BRE database make it sometimes difficult to conform.

**Adjustment percentage total**

BRE materials to be used in co-layers have an adjustment percentage. E.g. brick and mortar would be maybe 90% and 10%. This validation checks that the total adds up to 100%.

The user is allowed to enter a justification for not conforming to this rule. Again, the contents of the BRE database make it sometimes difficult to conform.
16 Cost planning and life cycle software

Some extra data is available when you are licenced to use some of the cost planning or life cycle software, which show extra properties available in the BRE materials or constructions using these.

16.1 Construction dialogs

The Project, System and Library construction dialogs have extra columns, and extra “IMPACT” tabs.

Extra columns

It is beyond the scope of this document to give details of these columns. Please refer to the cost planning or life cycle documentation.

Extra tabs

It is beyond the scope of this document to give details of these tabs. Please refer to the cost planning or life cycle documentation.

16.2 Materials dialogs

The Project, System and Library materials dialogs have extra columns, and an extra Additional LCC/LCA fields section.

Extra columns

It is beyond the scope of this document to give details of these columns. Please refer to the cost planning or life cycle documentation.

Additional LCC/LCA fields section

These are visible only for materials with category Floor finishes or Suspended ceilings.

It is beyond the scope of this document to give details of these columns. Please refer to the cost planning or life cycle documentation.